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||

v

SvsraNL couRANL

=
A

00000001
0000000000000

=

Ptz

1
W Fp13oat

! ruser

©

s [

SATA4  SATAS

ST SATAT

(SR SRR
NS

PCIE1

2.6.8 PCI #E7cHEE

KRR LUEBE & PCL RIS -
[2=] ©  ofF = =20

mam

Doooooo)

:0
15

©

[

s

g

D 2
S
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2.7 RERRERER

2.7.1 BRETE

BRI A S e S DU AR S A ARt PR IRUIRTE -

e 5VSB:

e o 0y ATX (ILEE 28 ORI R R > 6 H AR BER -

PSR 0 Y ATX (ISR AR R B E  BE AR - (BRI -
e VCC:

REZE T RHAEERE -
RV 0 RAEISRARA -

o0 =

Axazvt

a

$28eaa:

&

5VSB

LED1 mm

VCC

LED2 Wl
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2.8 Ef I/O kH

Silent-OTES™

I 1] ven @ @ LAN1

Mouse
o §°§°Z°Z°§° o sjor,  Lnedn IEEE1394 [ _ — —
Z © O[] | ml
B | ll "_r” CenSub.  Liné-Out
50 [ EE] @ — —
— @ [ @ 0O @%5}5 O RL/RR. _ MicIn

[

Keyboard Noprang oproutt ovin AUDIO1 USB1 USB2

e Mouse : 7% PS/2 15 E
e Keyboard : #i{5% PS/2 g

 Silent OTES : Silent OTES CE{HFIMIBEUEARAM ) Toid b nlsstat F AL v st Al 1 B -
JetGih AR o (FEORFFEENT T I )

e OPT-IN1 : s HEH nl R ARS HOLARER SHEE S/PDIF i A G R 2 BT s e -

e OPT-OUT1 : jthifBa nl - A el s S/PDIF it an sk 2 B s A -

e VGA1/DVIL: SHfZESHRIHA -

e AUDIO1:
S.L./S.R. (ZBE/AEE) EHE 7.1 BEE SR B H G B s -
Cen./Sub. (FE/HBESEE) © HiEE 7.1 U SRR P EEEL SRR S EE -
R.L./R.R. (ZEFGIEBRTEE) R 7.1 BE SRR U A% T8 -
Line-In : sEEEK SN E AR IR E i LAtk -
I%ingZOut DR 7.1 BEE SRR TR E LU TS - BRI T s
Mic-In : JHER [ SIS o A -

o IEEE1394 : EfZ (i ff] IEEE 1394 {2 1sid -

o LAN1 : i Emisiage -

o USBIL/USB2 : i USB 6 (bt  SRrpiess - Bobiss  WHBL - 900 - Seinds -
BT - HoR -
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3. BIOS 5% E

ARt A2k EEPROM ZCIE RS (L REEHT BIOS fit 2= - BIOS( Basic Input/Output
System) JEEpm M ds Bl Rl ACE 2 R Mos sy —TERE R o UETERSE T - SHTHHRRRA -
SRR "Run Setup” BUBERING S BRI E] BIOS BUE - AREMATR A BIOS AL
HHIBCEVIRE ©

TERAPIME % - BIOS RS HBAER AL I - FClSIS A mbtaa > TR I
PRESS DEL TO ENTER SETUP

WFSEEAESEEEIEZATAL > Fte<Clrl> + <Alt> + <Del>FAREMPHH - 802 T BRY
Reset §f - A ERHGERITE T2 BRIEEAEIRL » T pER BB -

1T <Del>$itft » EHTHBRIBIATT -

Phoenix - Award BIOS CMOS Setup Utility

» SoftMenu Setup » PC Health Status

» Standard CMOS Features Load Fail-Safe Defaults
» Advanced BIOS Features Load Optimized Defaults
» Advanced Chipset Features Set Password

» Integrated Peripherals Save & Exit Setup

» Power Management Setup Exit Without Saving

» PnP/PCI Configurations

Esc : Quit | o< : Select Item
F10 : Save & Exit Setup (C51PVMCP51-6A61HA1BC-00)

Change CPU’s Clock & Voltage

¥ RT7BERGREMRRE  BRMAINIEMESFEREER BIOS RIE - £AFMARTTIHAY
BIOS e EH S REMH LS EMMA » TR GEEER LATRIINTRMER -

NF-M2 nView 3-1
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3.1 SoftMenu Setup (CPU £%7F)

Phoenix - Award BIOS CMOS Setup Utility
SoftMenu Setup
AMD Athlon(tm) 64 Processor 3800+ Item Help
Frequency : 2400MHz
CPU Operating Speed Default
X - CPU External Clock (MHz) 200.0
X - PCIe Clock 100Mhz
X - Multiplier Factor x12
Voltages Control Default
X - CPU Core Voltage 1.350 v
X - DDRII Voltage 1.80 Vv
X - DDRII Reference Voltage Default
X - Chipset Core Voltage 1.20 v
X - SB Core AUX Voltage 1.50 v
X - Hyper-Transport Voltage 1.20 v
} | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Brand Name
SE{FE H g CPU [RIBE &5 -

Frequency

SEMHE H #R CPU H PR IRAER -

CPU Operating Speed

3& (T E AR AR T 1 g B 28 QDR R 2 B B B e s 8t T DLgE S [User

Define] (fifi FHFEREE ) AUEEEAR T am A LEH Y -

User Define :

M BERETERNEERBLURINDRIR - A RSN RIE R ERENER - S LIER
HENEA PCI BRAERREERIHE KA REDEERAREETFE - ZEE

# - ERERRA - B E LEAEEREEERMNELERERS AU ERES - &
ERHRECRE  BEREIRARZ L MULSFAR—RERREZT -

X BAIERBHRBLONREER  MIUERFRE - RIERERMEREMRTH AR
ENER ' TREE[EE -

- CPU External Clock(MHz)

saflivE HEeE CPU HUSMEHTE © ZERANEFTZe4eHy CPU Bk » ifaseE it H AR HEHE S e
S SR o H AR -
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- PClIe Clock

IR H ]38 PCT Express SRR IRAGTR -
- Multiplier Factor

SEfE P H BRI & ey CPU HRS SRS S -

Voltage Control

SRS TTLA ARSI 265 2N - B E AT R SRR
B > EEFHHE TR - " User Define | 3 (HEIEATI LU FRHE YNGR -

- CPU Core Voltage

- DDRII Voltage

- DDRII Reference Voltage
- Chipset Core Voltage

- SB Core AUX Voltage

- Hyper-Transport Voltage

¥ BENREENIER  TRESENARARE - ERHEK CPU 8K - MRMNRELSNAE
LM » BRIFAEXNERRENAR °

NF-M2 nView 3-3
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3.2 Standard CMOS Features (&% CMOS Z8:8F)

Phoenix - Award BIOS CMOS Setup Utility

Standard CMOS Features

Date (mm:dd:yy)

Time (hh:mm:ss)
» IDE Channel 1 Master
» IDE Channel 1 Slave
» IDE Channel 2 Master
» IDE Channel 2 Slave
» IDE Channel 3 Master
» IDE Channel 4 Master
» IDE Channel 5 Master
» IDE Channel 6 Master

Drive A

Drive B

Floppy 3 Mode Support

Halt On

Base Memory

Extended Memory
Total Memory

Thu. Jul 27 2006
12 : 34 : 56

None
None
None
None
None
None
None
None

1.44M, 3.5 in.
None

Disabled

All, But keyboard

640K
1046520K
1047552K

Item Help

{}><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:GeneralHelp

F5: F6: Fail-Safe Defaults F7:

Previous Values

Optimized Defaults

Date (mm:dd:yy)

efEEEEL [HT~ [HT ~ Pk [#F] mutg=aaee fadaeny H ] Gak 23iqrmmg HiD

Time (hh:mm:ss)

SEfEEEEL ]~ [53] ~ Uk [#] ks ke e BB EImRs il Gas 2 BAERIR )
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% IDE Channel 1 Master/Slave, IDE Channel 2 Master/Slave, IDE
Channel 3 Master, IDE Channel 4 Master, IDE Channel 5 Master,
IDE Channel 6 Master

% <Enter> gl A2 ¢

Phoenix - Award BIOS CMOS Setup Utility
IDE Channel 1 Master

IDE HDD Auto-Detection Press Enter Item Help
IDE Channel 1 Master Auto

Access Mode Auto

Capacity 0 MB

Cylinder 0

Head 0

Precomp 0

Landing Zone 0

Sector 0

{}><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:GeneralHelp
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

IDE HDD Auto-Detection
HEVEREFIEFE DL T <Enter>Hg AR (el IDE $EEHI2 8 » B2y At SR s L -

IDE Channel 1 Master/Slave, IDE Channel 2 Master/Slave, IDE Channel 3 Master,
IDE Channel 4 Master/IDE Channel 5 Master/IDE Channel 6 Master

HRUER [Auto] (Uj‘iﬂ) I » BIOS JKrey H Bl it A o2l FIVIRRERY IDE 26 - AR H Ok

SESGES MRS > SR HRGER [Manual] (F8)) - i HIEE g — B BT R R EE -
EE ”*%%I_MF‘-‘E}?ETM SRS ST 2 A R

Access Mode

SEfETE H AR IDE SaEny R - GH TR E [Auto] (HE)) #URCE » # BIOS HE)
eI @MT&H’J{%EXT%JQ?JETU\T

Capacity

B E TR AR B W] P A 2 S S LR FIT U ) A B E R KA FH G iehen AR =0
TEH A AR 75 1

Cylinder
SEMEH H AL -
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Head
s& {8 H AH RERA/ S aar g e -

Precomp
SEMEME B #R T DASCE s ARG E -

Landing Zone
S E AT R R OB T T A R e, -

Sector
JEMEME B AR TR e -

% [@%] Standard CMOS Features (fZ#t CMOS 285w ) WFEH ¢

Drive A & Drive B
TEEME H 3 T SR CEE 2 A TR ) B0 -

1

Floppy 3 Mode Support
SEAEE H A E H AR ISR B T3 Mode Floppy Drive ;- ] USSR A ~ B 52

Both (WIEH]) - ARENZ A B HALHER RIS ENRT - S50 HIH{E [Disabled] (B
) HIBCERERILLT -

Halt On

eV H W RE B RAAE B AR P - e B3R A R 75 S 1 R B -

[All Errors] : ZARGHISAR P e ik - R BIOS (el RS

[No Errors] : SRR AR A G R B TSR TR 2T 11 -

[All, But Keyboard] : 5t bl BA% 5 & IR B AT (Sl (U R T4 o » Bk T SRR SR AL -
[All, But Diskette] : 5L 7 & TR SE ARG ERIBT T 15 > BR T R O giaseA

e
[AIl, But Disk/Key] : i 76 61 D55 (ERISEAURL TSR L » W 7RG o2
LIS -

Base Memory

SEAFE ORI R AR A SERETHRAA B SR 640K 1 FAEFT TS
1 - 640K 8 25 22 - . - e -

Extended Memory
SEAEE H BRI R AR AR P P I S e Sl sy A )N -

Total Memory
SEfEE HEURH R A v R R R/
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3.3 Advanced BIOS Features ( BIOS 3&EPETHREERE )

Phoenix - Award BIOS CMOS Setup Utility
Advanced BIOS Features

Quick Power on Self Test Enabled Item Help
» Hard Disk Boot Priority Press Enter

First Boot Device Floppy

Second Boot Device Hard Disk

Third Boot Device CDROM

Boot Other Device Enabled

Boot Up Floppy Seek Disabled

Boot Up NumLock Status On

Security Option Setup

MPS Version Ctrl For OS 1.4

Delay For HDD (Secs) 0

Full Screen Logo Show Enabled

||><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:GeneralHelp
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Quick Power On Self Test

¥R [Enabled] (EABY I  SE(HIF FI{ERHTIRAIE.2 % - w113 POST (Power On Self Test)
HTST - BIOS 1k POST i PRI —SLiE s -

Hard Disk Boot Priority

JEETE H RSSO SIERS » #EFRTE T <Enter>[fadi » SR DGE A CHY TR Ca
AR BT AT DA AECE R BB A R - DU A Bl 247

LI LhRE(E - AF First/Second/Third Boot Device & H i {F-i—{@E H45 [Hard Disk] [)358IER /7

JIH

|

K

First Boot Device / Second Boot Device / Third Boot Device / Boot Other Device

1 [First Boot Device] - [Second Boot Device] Lk [Third Boot Device] H9IE H & rhis il s
B~ BN =IE BRI SEE - BIOS B iR AT BMEEE » (RIRIE P2 B2
T AN A i = (AR DA SEE AR BAREIRE - G [Boot Other Device] (phHAthEE
BAkE) 325 [Enabled] (X&) -

Boot Up Floppy Seek
i E B [Enabled] (&) KF  BIOS Bk Alb ki 2eaE s e 19 &ess -

Boot Up NumLock Status
S AP H e S R e R PRI THE RS -
[On] : S5 gls MBS i AR

NF-M2 nView

Flks so1d



[Off] : Sl PO 1F AR -

Security Option

e fEVE HOE RN SRR SR — SRR O A BIOS BER «
[Setup] : LG5t A BIOS 2% Iy 7 A B -

[System] : 7GSRI A\ ZE0 -

X TEETECRENER  B—TiLT » ColEFE—& » fTRMR - BBER CMOS &
RER + ZAUEHRE - MEFTERESERNERR » LRV ABENRE R -

MPS Version Ctrl For OS

:JI FIEE B AR E (I EIR MPS (Multi-Processor Specification) R - G frE IL#EIHES
TR -

Delay For HDD(Secs)

FEHFERSLACTERF A > SE {5 H st BIOS Soff—th g i B2 RiRRY IDE 2808 - MOARYBE ] LA
PEAGHEE S RAVIEEIRFE] > DIRE A B Ehe B -

Full Screen LOGO Show
SEMEMEE e BRI S S B R R -
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3.4 Advanced Chipset Features ( 5 F#ERTIES ST )

Phoenix - Award BIOS CMOS Setup Utility
Advanced Chipset Features

K8<->NB HT Speed Auto Item Help
K8<->NB HT Width Auto
NB<->SB HT Speed Auto
NB<->SB HT Width Auto
» DRAM Configuration Press Enter
HT Spread Spectrum Disabled
SSE/SSE2 Instructions Enabled
System BIOS Cacheable Enable
VGA Share Memory 64M

||><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:GeneralHelp

F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

K8<->NB HT Speed
[EIE H e b R P B AR B LR L 2 IR LDT REFRHRSER -

K8<->NB HT Width
Lo H g SR B s B LA S i iy LDT RESHRSE -

NB<->SB HT Speed
IR EE R UG AL F B R AG  Fri [lfY LDT MEVR HR -

NB<->SB HT Width
ST R I LAR o Bl A it i (IR LDT SRR -
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DRAM Configuration
# <Enter> HEAGEAH T-HIE -

SR AR 72 H 2K T-H3H % DRAM IRFIRENE - o2 47(r. DRAM ERI) SPD (Fp51)
) B ERITHRGE

Phoenix - Award BIOS CMOS Setup Utility
DRAM Configuration
DRAM Timing Selectable Auto Item Help
X - DRAM Clock DDRII 533
X - TwTr Command Delay 2 Clocks
X - TrfcO for DIMM1 105 ns
X - Trfcl for DIMM2 75 ns
X - Trfc2 for DIMM3 75 ns
X - Trfc3 for DIMM4 75 ns
X - Write Recovery Time (Twr) 4 Clocks
X - Precharge Time (Trtp) 2 Clocks
X - Row Cycle Time (Trc) 17 Clocks
X - RAS2CAS R/W Delay (Trcd) 4 Clocks
X - RAS to RAS Delay(Trrd) 2 Clocks
X - Row Precharge Time (Trp) 4 Clocks
X - Min. RAS Act-Time (Tras) 12 Clocks
X - DQS Timing Training Skip DQS
X - CKE Base Power Down Mode Enabled
X - CKE Base Power Down By Channel
X - Memclock Tri-Stating Disabled
Bottom of UMA DRAM [31:24] FC
Memory Hole Remapping Enabled
DRAM ECC Enable Disabled
X - DRAM MCE Enable Disabled
X - Chip-Kill Mode Enable Disabled
X - DRAM ECC Redirection Disabled
X - DRAM Scrub Rate Disabled
X - L2 Cache Scrub Rate Disabled
X - DCache Scrub Rate Disabled
Auto Optimize Bottom IO Enabled
X - [31:24] IO Space CcO
{]><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1l:GeneralHelp
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

% [E%] Advanced Chipset Features (5L AHEFSTHRERBELTE ) X E
H:

HT Spread Spectrum

IHESEIE 2 T EMC ( EIectro-Magnetlc Compatlblllty Test) JHERIRHE IEAHFE ST ] - —
A FH R AN Er T SR S e H > THE(E RS Disabled < 55/]v 0y B2 IR » FELb B e
R A REE Z TH LR -

SSE/SSE2 Instructions

AIEAFEE TEnable ; (J%H)sk " Disable | ({52F])SSE/SSE2 (Streaming SIMD Extensions)f‘j$54y
#(instruction set) - TH&{EFS "Enable ; (f&f) -
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System BIOS Cacheable
IEIE E n]E S IREGRAE BIOS » #E UG Tl -

VGA Share Memory
AIEH LR VGA 52501 RE (VGA share memory size) A/ »

X RAETRESOWAREESENME TR BIOS ARBIANETBRELBHET SR
HYBKE - BI2N : TERMACIEER 256M RI1EIT T2# 256M - BIOS AREN SIS B
{54 128M -

NF-M2 nView 3-11
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3.5 Integrated Peripherals (24iBi25%F)

Phoenix - Award BIOS CMOS Setup Utility

Integrated Peripherals

» OnChip IDE/RAID Function Press Enter
Init Display First PCI Slot
OnChip USB V1.14v2.0
- USB Keyboard Support Disabled
- USB Mouse Support Disabled
OnChip Audio Controller Auto
OnChip LAN Controller Auto
- OnChip LAN Boot ROM Disabled
Onboard 1394 Controller Enabled
Onboard FDD Controller Enabled

Item Help

||><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:GeneralHelp
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

% On-Chip IDE/RAID Function
% <Enter> #oGHE A T-EIm ¢

OnChip IDE/RAID Function

Phoenix - Award BIOS CMOS Setup Utility

» IDE Function Setup Press Enter
» RAID Configuration Press Enter

Item Help

{}><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1l:GeneralHelp
F5: Previous Values F6: Fail-Safe Defaults F7:

Optimized Defaults

3-12
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% IDE Function Setup
1% <Enter> $HEAF T-HIH ¢

Phoenix - Award BIOS CMOS Setup Utility
IDE Function Setup

IDE 1 Controller Enabled
IDE 2 Controller Enabled
IDE DMA Transfer access Enabled
OnChip SATA Controllers Enabled

Item Help

F5: Previous Values F6: Fail-Safe Defaults

{}><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1l:GeneralHelp

F7: Optimized Defaults

IDE1 Controller
s A] DUSE R AP B2 RRA IDEL PEHI2R -

IDE2 Controller
JEEEEE ] DU AP EOR R R IDE2 PEH2% -

IDE DMA Transfer access

BEIE H AT IDE SEsEE g 2eiE .2 DMA i -

OnChip SATA Controllers
BETE H I I s I SATA REdil &% -

NF-M2 nView
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% RAID Configuration
1% <Enter> $HEAF T-HIH ¢

Phoenix - Award BIOS CMOS Setup Utility
RAID Configuration

RAID Function
X - Serial-ATA 1 RAID
X - Serial-ATA 2 RAID
X - Serial-ATA 3 RAID
X - Serial-ATA 4 RAID

Disabled
Disabled
Disabled
Disabled
Disabled

Item Help

{}><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1l:GeneralHelp
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

RAID Function

I H fea a5 Serial-ATAL~4 Stz F1 RAID IijfE
- Serial-ATA 1 RAID ~ Serial-ATA 4 RAID
IETH H ARG A sl 1 Serial-ATA1~4 il F (1) RAID DJRE -

% [EZ| Integrated Peripherals (#&35E:85%%) WEXEMH :

Init Display First
TR RS i O SR -

OnChip USB
1% USB PRl as iRt -
- USB Keyboard Support

{EA SR USB SRR S 26 R4 (FEAER DOS) 2

- USB Mouse Support

FEA SR USB i ERIES A ESER M (LLaE DOS) 2 »

'R [BIOS] (FHRHE) -

aigefE [BIOS] (FHaAH) -

OnChip Audio Controller
SEAE B SRR R S R A

3-14
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OnChip LAN Controller

SE (I EEBEE BB LAN £Edies -

- OnChip LAN Boot ROM

S EE H AR B ROM (LI ABEGERE ) SRBHIHE ACRAR - i H Ay DU S I i s s -

Onboard 1394 Controller

BRI TEEE 1394 #s -

Onboard FDD Controller
S M T B B R PRI 2 -

NF-M2 nView 3-15
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3.6 Power Management Setup ( EREPIENXEE )

Phoenix - Award BIOS CMOS Setup Utility
Power Management Setup

ACPI Suspend Type S3 (Suspend-To-RAM) Item Help
- USB Resume from S3 Disabled
Power Button Function Instant-Off
Wake up by PME# of PCI Disabled
Wake up by OnChip LAN Enabled
Wake up by Alarm Disabled

X - Day of Month Alarm 0

X - Time (hh:mm:ss) Alarm 0: 0 : 0
Cool’n’Quiet Technology Auto
Power On Function Button Only

X - KB Power On Password Enter

X - Hot Key Power On Ctrl-F1
Restore on AC Power Loss Power Off

{}><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1l:GeneralHelp
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

ACPI Suspend Type

Sl R AR R

[S1(PowerOn-Suspend)] : [j#% Power On Suspend IHfE -
[S3(Suspend-To-RAM)] : i Suspend to RAM TffE

- USB Resume from S3

HRGER [Enabled] (%)) I - & {2 H AT H] USB 2EEskififi/E S3 (STR - Suspend To
RAM) JIRREFHRHE - LUF/EEH TACPL Suspend Type | JZ&ciz/E [S3 (STR) ] I - i&fiEH
JIRESRRIEEMEOE -

Power Button Function
SEEIE H A ACE R R AR B IR =0

[Delay 4 Sec.] : Frgiituta L BEIEHLHEA BOEEE IR S HI TR RAR A BRI - 38T ARG R E
AN BOEE N RN NSRRI SRR -

[Instant-Off] : & N RIRFRDHE I — R - S LR PH R -

Wake up by PME# of PCI

$Ep2 [0 (Enabled)] 15 » (L{AMEAI PCL - LA (AR5 AR, Soft-OFf HiHE Rty
i - 3% PCL R AUESTIRREDIRE -
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Wake up by OnChip LAN

S [P (Enabled)] 1% » (FAMPyE LAN It FAEIUII AR BRI S Soft-Off JRAE 1) 7%

Wake up by Alarm

HEERS [Enabled] () W » ] DASEE BT S LUK A (Soft-Off ) FE = B b &Y
HEALAUR SR » EMM2LL T Date (of Month) Alarm | [/ f; " Time (hh:mm: ss) AIarm o H9IE
EIRMERE « ANEUURT » ISR RIRATLLRCE R BT AR TR ER s (S /W Isies )
WBoEFFIENE - SRR EE S AR FE B S » DU BR i -

- Day of Month Alarm
[0]: BLEETERF rIfkiEAE T Time (hhimm:ss) Alarm 35 H e & IIRFHES R R R A BRI BHAET

[1-31]: phsesER n s At SR R AR FR IRBH R H T - SR fEATa ﬁmH R R A R
b - 3l HLE Time (hh:mm:ss) Alarm 35 H HrpfTas & BRR ] A ) 2

- Time (hh:mm:ss) Alarm
[P TR A A R SR AR FR BT IRR (] -

Cool 'n’ Quiet Technology
L SETE Ay DABA RS o S BEER AMD K8 vl K iy shhe

Power On Function
LSRR AR R A B R R B B 5 = -

[Password] : {f 155 ACBIE AR T + ARSI <Enter> He 4 A L5
5+ (2 MDA (B57C » ARAAFTHA 52— BTG - Bt N <Enter> B AceRRI Y
fe -

[Hot KEY] : i 1] <F1>H|<F12> rRET—{E ) RER A R I -
[Mouse Left] : Sy B /- R B R B I

[Mouse Right] : 85 Bl A B R A B IR

[Any KEY] : { F{T-— (S AR BRI A PR IR -

[Button Only] : {5 FH TR IFHL SRR B R B -

[Keyboard 98] : {if "98 BLfgis | MHA G LAY TEIFIZHARBHRE S ERIR -

¥ MERMER PS/2 BERTRRIRIEAITHEE - ML COM B3R USB AIXMBER -
B PS/2 BRAREKRMIRE - RRTMAEAM CHME - IRCERNOAREANEE
HOEE + ATRBSEAS R EIRBARK

- KB Power On Password
[P SR T T R A R RS B T T S FH R 15
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X EAETRTENES BRIV EER CMOS Y B SRFAAMNSE - DI RMER
ItEThEE -

- Hot Key Power On
ST ] AT AT IR R T <Crl> g P AT (EE(<F1> ~ <F12>)ABER

Restore On AC Power Loss

ISR TR P SRR A U PR IR S AR I R

[Power Off] : 2 i d RSO EIE LA - ARMAYEIFHERERIPHRIRAE BT N b
A ABHE R AR BRI -

[Power On] : &7 ARSI EIE IS - SRR A 5T 1 St -

[Last State] : &2y BIRIAAGIRIE UL - SRR RUREI B IR RE A 2 BTHIARTE - ANRRAE
{ERERAR R A i RIS A SR PRI » 5 PR IR RIS R S HE R (AR R PARIIARE - 2021
AMAERIRK A ARG T RIFPIEIGRE - & BRI E R G R E R IR IIRTE -
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3.7 PnP/PCI Configurations (PNP/PCI #HKEERF )

Phoenix - Award BIOS CMOS Setup Utility
PnP/PCI Configurations

Resources Controlled By Auto (ESCD) Item Help
X - IRQ Resources Press Enter
PCI/VGA Pallete Snoop Disbaled

** PCI Express relative items **
Maximum Payload Size 4096

||><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:GeneralHelp

F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Resources Controlled By

S flEvE H TP BB DU BRI Y AR G E e TR BB -
[Auto(ESCD)] : itk 5 Bt IFr A HIREE -

[Manual] : 7£ "IRQ Resources ; ;& R 2R IRQ &EF »
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- IRQ Resources
% <Enter> $GHEA R THIH ¢
SEEH HATRCGE S BRI TE [PCI Device] =22 [Reserved] Huzff—%

Phoenix - Award BIOS CMOS Setup Utility
IRQ Resources

IRQ-5 assigned to PCI Device Item Help
IRQ-7 assigned to PCI Device
IRQ-10 assigned to PCI Device
IRQ-11 assigned to PCI Device

{{><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:GeneralHelp
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

% [E1Z] PnP/PCI Configurations (PNP/PCI {HREZE ) FITEE

PCI/VGA Palette Snoop

SE {5 E nT e ke MPEG ISA/VESA VGA RJLL (Ho2 A EE) B PCI/VGA —ildifF -
[Enabled] : MPEG ISA/VESA VGA - /g PCI/VGA —HSEfE -

[Disabled] : MPEG ISA/VESA VGA A gefi PCI/VGA —ifEid E -

Maximum Payload Size

BEIE H ke PCL Express 2L TLP s Rk -
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3.8 PC Health Status (EBS{EELREERT)

Phoenix - Award BIOS CMOS Setup Utility
PC Health Status
CPU Shutdown Temperature 90°C/194°F Item Help
CPU Warning Temperature 80°C/176°F
FAN Fail Alarm Selectable CPUFAN
CPU FanEQ Control Enabled
- CPU FanEQ Target Temp. 55°C/131°F
- CPU FanEQ Temp. Tolerance 5°Cc/ 41°F
- CPU FanEQ Start Control 80%
- CPU FanEQ Stop Control 50%
SYS FanEQ Control Enabled
- SYS FanEQ Reference Temp. System
- SYS FanEQ Target Temp. 35°Cc/ 95°F
- SYS FanEQ Temp. Tolerance 5°Cc/ 41°F
- SYS FanEQ Start Control 70%
- SYS FanEQ Stop Control 50%
CPU Temperature 42°C/107°F
System Temperature 30°C/100°F
PWM Temperature 42°C/107°F
CPU FAN Speed 3245 RPM
SYS FAN Speed 0 RPM
AUX1 FAN Speed O RPM
AUX2 FAN Speed O RPM
CPU Core Voltage 1.37 Vv
DDRII Voltage 1.77 v
DDRII VTT Voltage 0.89 Vv
Chipset Core Voltage 1.20 v
ATX +12V 12.00 Vv
ATX +5V 5.00 v
ATX +3.3V 3.30Vv
||><:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:GeneralHelp
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

CPU Shutdown Temperature
[P ] DA G AR AR H BRI OIRL S » DU SRR A L

CPU Warning Temperature

SRR DL SRR 3 P S » 25 A BB R A ML U - 255
R L -

FAN Fail Alarm Selectable
AP ] A R e SR o

CPU FANEQ Control
AW TR CPU R ERIIELE - 3 E RS [Enabled] () IFf » THI#p- Rl 8 50 7 m] 8RR

HE o
- CPU FanEQ Target Temp.
AIH M PARE T CPU FanEQ |, DIRERIEF HIIRLAE -
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- CPU FanEQ Temp. Tolerance

AIEEMLIEE T CPU FanEQ Target Temp. | HYAFHEME]

- CPU FanEQ Start Control

AIEE DR E T TCPUFANL | H2H 1y 4 SHEUZAHA R IGH0R L -
- CPU FanEQ Stop Control

ATEH FLAREE B R B2 XY T CPU FanEQ Target Temp. , T HAEEM | "CPU FanEQ
Temp. Tolerance ; 5 H FISIEF IR - iHEErE " CPUFANL | $255 1 4 SRR AH R IR (sl L

AR (EEIR B iE 74 T CPU FanEQ Target Temp. [ ZH H 84 fiErj |- " CPU FanEQ Temp.
Tolerance ; 35 H B8 fBIRHf - SEBAE " CPUFANT | B20H 1Y 4 STz HA RS & T CPU
FanEQ Start Control , 25 H s E A BRAAE - B 12715] 100% -

X EFEATIL 4 &t TCPUFAN1 ) RS EIRIEE LM 3 stEGAN AR FEREGITEE -

SYS FanEQ Control

AP TR SYS RO - BERS [Enabled] Wy TRV EIESETE F3 AT EIUIRRE -
- SYS FanEQ Reference Temp.

A H LA E FERR BRI 25 8 - 3204 T System ; LUK TCPU -

¥ EEREEER 3 HMNRESESARKRR KA R ThEENEE « A :
1. 3 3 SRR AR TSYSFANL | REEREEL -
2. & TSYSFanEQ Reference Temp. ; ¢T84 "System | #pk "CPU,; -

- SYS FanEQ Target Temp.

ATEHHLAE TSYS FanEQ | THHEAJE FHIELFE -

- SYS FanEQ Temp. Tolerance

AIHH A LAREE " SYS FanEQ Target Temp. | (Y73l -

- SYS FanEQ Start Control
AIEE F LA AT T SYSFANT | #4250 B 3 SHAE AT IR LEL -
- SYS FanEQ Stop Control

AIEHE LI EE T SYS FanEQ Reference Temp. | R KA T SYS FanEQ Target Temp. | JEHAY
BE - " SYS FanEQ Temp. Tolerance | 3 H AV SR - s@844E " SYSFANL | £208 Y 3 §F
J B A Y G T

‘& T SYS FanEQ Reference Temp. | 7B A (SHIZN Y #5E=5Y T SYS FanEQ Target Temp. | JEH Y%K
fEfin L "SYS FanEQ Temp. Tolerance ; T HYSSUEYRE(E - HEE(E T SYSFANL | 288 11y 3 $Hl
AR EEEGR Er 1 T SYS FanEQ Start Control | 35 H HhAE e rEhaBH ia B ert2] 100% -
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FrEER - BRlERimERRE

TE I H Sy IR BB s DU ~ U L . (P il DU il ) <53 > &

A F B A i L i

3.9 Load Fail-Safe Defaults (& A c-L2 B2 FE%E)

SRR A BIOS HYMIRTHRL(E - MRS EARE - B SAURENTRAMARIE -

r 1

3.10 Load Optimized Defaults (& A R{E{LNRETEERE )
SEEEEIE A BIOS IKH RTINS iR e SR -

3.11 Set Password (SRFEZE)

e flEerEa = BIOS fHIE SRR PRI A S -

w

12 Save & Exit Setup (B EFERBESRTEZE CMOS)

WSETE R IR E PR BIOS S E e -

r‘ f{l

3.13 Exit Without Saving ( BB {E A FEREZE CMOS)

Sa fEEE AR ROEHBR T BIOS 3 E3EH
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4. BEEFE VAN BRELRIE

Kt " ERENRE U A IR OURR ) NS B A SRS A B RS THRE AT TR <SRBI =X -
NS W T L G

T T EEENTECEL A TR O ) OB RA R - R LU R 228 A B T -
AR BT - S LU SR BB R AR 8 /7R MEBE TAUTORUN | A%< -

abit nForce Series Motherboard

| Drivers ‘ Manual Utility ABIT Utility

n¥idia nForce Chipset Driver
n¥idia Graphics Driver
Realtek HD Audio Driver
Cool'n'Quiet Driver

USHB 2.0 Driver

-
a blt Browse

cD

o [Drivers] : BlE R E ASRHIRE LG8 R

o [Manual] : B LR E A G TMhE

o [Utility] : BISEIbERE ARS8 -

o [ABIT Utility] : Bis2bpE A ABIT MiZ BrZEHY A TR =02

o [ Pugititll Browse CD] : 2 hyiBes " SRl Nen A R =00 rINE -

. [Close] SR B 2 L
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4.1 nVidia nForce & 5 BEEEIF2K

BLBEEERERE
1. (ELdEEEEm NEE [Driver] H54 -
2. #hEE [nVidia nForce Chipset Driver] - jEHERLL N -

NVIDIA Windows nForce Drivers

Welcome to the InstallShield Wizard for NYIDIA Windows nForce Drivers

3. AR LRI TR RS -
4. EHTETRGREETA AT -
¥ ETERETIREFE RS %554 NVIDIA nForce Chipset B2, -
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4.2 nVidia BE;REEEIFEN

AR B A R e A BE R THIIRE -
EZEEEERREE

1. fEZdGEEEH NEGE [Drive]] 24 -

2. BE% [nVidia Graphics Driver] » JHFR LA 5@ -

NYIDIA Windows XP Display Drivers

Welcome to the InstallShield Wizard for NVIDIA

3. GRS AR T -
4. EHEERVEREEIREAPHIAER] -

NF-M2 nView
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4.3 Realtek 5 REEHWEFHER
EREE [EREEE

1. {ELSEEHEER FEGE [Drive]] 4 -

2. ¥h% [Realtek HD Audio Driver] » & HFR LU A -

Realtek High Definition Audio Driver, Setup (2.14)

‘Welcome to the InstallShield Wizard for Realtek High Definition Audio Driver

InstallShield < Back

3. FHREBEE AR AL -
4. EHTERMAERIIEARGIEM -

Cancel
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4.4 £3£ Cool 'n' Quiet EEFHFEX
BERESEEREEE

1. e T ELE [Driver] 24 -

2. B# [Cool'n'Quiet Driver] » HIFRLI N2 ¢

AMD CPU Driver Setup

Welcome to the AMD CPU Driver
_A‘M D Installation Wizard.

Thiz wizard will install the 32-bit version 1.3.1.0 of the &MD
CPU Diriver,

Athlon

To continue, click Mexst,

| Mest> |[ Cancel l

3. FEIRBEE RIS
4. EREDRTEEEERE AP ER] -

NF-M2 nView 4-5

SLiin> B i



5.

(ERAE TR - GHTEIERIS hisesE T EEYRETE , (Power Options) » AR5 T iR/ NEE R

& | (Minimal Power Management)iy & /ﬁ'ﬁ@ﬂ% LU Cool *n’ Quiet 44 FE ] -

Power Options Properties

Pawer Schemes | Advanced | Hibemate | UPS

" Select the pawer scheme with the most appropriate settings for
L thiz computer, Mote that changing the settings below waill modify
the selected scheme.

Power schemes

Home/Office Desk w

Home/Office Desk.
Portable/Laptop
Presentation

Ture off monitor: After 20 mins £3

Turn off hard disks: Mewver w

System standby: Mewer w
[ Q. l [ Cancel ]

¥ #H¥ Windows 2000 3% ME f9{EZZ %t - AMD #J Cool 'n’ Quiet IHREIERDIERER

Windows 2000 £; ME 35 #9 Cool 'n

" Quiet ZKEEF HR1E BIREH ((Power Options)

B o IRThEENARTER | BEE | (Automatic Mode) » #Niit Cool 'n’ Quiet i
A B -

4.5 USB 2.0 EiF)#2z(

¥ 71£ Windows 2000 Service Pack 4 - Windows XP Service Pack 1 FEZBERANIEZE
R MRARKEERSHELN -
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4.6 ABIT EQ (FERSEERDMEAIFE)

ABIT EQ J2H1 Universal ABIT fifrasg it 2 DAITEASM RS A MELA FE I H B2t - & ] DARE
PEEIRHLEAR TR - CPU R U dt KR CPU R A AR S5 B G T 2Rt () N\ TR -

HLESEEARHER
1. {ELcBEs b A [ABIT Utility] #524 -
2. Bl [ABITEQ] - REHIRLIT 0 -

InstallShield Wizard X

Welcome to the InstallShield Wizard for ABITEQ
- Y1028

The InstallShisld® ‘wizard will inztall ABITEQ %1.0.2.8 on
your computer. To conbinue, click Mest.

Cancel ‘

3. EIRBEE RS
4. EHTEERMEAHEARGIEN -
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5. A Windows 5 Bt “BAR HeBL > (&I ESREE D “ABIT S “ABIT
EQ”

6.  ifEA ABIT EQ 72k - BERNMEHLL NEH « AMTERE - MG MR r R -

—— e

" ABIT EQ Temperature VGIagE Fan
liem Value Li Status
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4.7 ${{F NVRaid B

AR AR S T B ISR SATA BEEIRE 0 - AT ESS —{y SATA BBt =) -
ST —REERE R ¢

1. R MEE [ABIT Utility]] £24 -

2. BE% [Generate NVRaid Floppy Disk[32bit]] - & H LA N -

Floppy Disk Generator, §|

Type:  n¥idia SATA Raid driver Disk 1.08

Source CheckSum:  0x4202 BLild

Pleaze s_eleu:t ane floppy and inzert a blank
floppy dizk. Abaut

Ak ~|

122 IR FT AT ERR AP  dfEGE [Build] -
3. B [OK] #%3R SATA BBl i TR -

Message

L]
1 Build Completely, and Destination checksum: 0x4202
e

4. EEE [Exit] SRAOEESEAE BETA -

¥ A Windows 2000 {EEZR#R  BNFARE NVIDIA RAID 2Hl » A RGKEFE
Service Pack 4 -

NF-M2 nView 4-9
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5. Bff&%

5.1 RMMEHRR (MAERGRIEZE"? )

5.1.1 %

Fl:ﬁ :

b

0¥

]
dm

%

]
dm

%

ERERA ST EMIAR R EMFR Al BEYZH EHIRMOSER CMOS &)
1EIS ?

DB PR AR R AR A R CMOS BB - FkF CMOS rypkiEesH (Jumper)

FFRRY 1-2 S ALERE E 2-3 JlliEER CMOS HZENGRE HAG AT A TO SRR ] > IR
BB I B AR 1-2 GRS RI AL © 5 — KBAR - S I T ARSI A BIOS
IR{EALRIRECEN -

: AIRERIEEST BIOS RERE T HRNAERSBBEMERRTMEARE - BEXE

37

CONVERGERESERT BIOS BURIAE T SEIRAYER I a2 M HTT SR R AN - SR

CMOS BN A 14 FHET TRREREY B -

! RITEMIR B RSB EIRE AL ?

R DB M [ - RHORRT 30 DL ERIMHIFRIG ] -

! RfHELTE BIOS N ERFRERIFRENRER ARBERK SR8 L ERRERR?
¢ A EAE BIOS GBI IR H RO MPSECRAR IR AP  sE ks EARI A H%

{HF5FF CMOS FUsk kg kR - [EHEEREES TR EAI AT - F AR S RMA SRIETT: -

PAVERALL T =R bR T U e = E RS ¢

AR KRR LERIBERIYIZE OFF (& R IRIEES AR - MIRGE Ben g E IR
RS — DR IE R IR B ER I -
g IR <Insert>HFEiL > [RIRHE TPHIEEDIN - RrFI DIt S A
<Insert>zgt » IRt <Del>Fitk A BIOS 55 o i DAET IEFERIRRE
fEEAGE — IO E AP - AR =R - s TR 2 -

BB 2. RFFEIRGUERS LIERIBARHTIE OFF (i - i ra IR AL BRI A bR » AREE 2R sk
REERES: - FTRHMGR - K CCMOS BERRETHRRAY 1-2 (U 2-3 (7 —708i - LUF
Fx CMOS #okt » [RUETHRR (M - ANikdEE] 1-2 {7 -

R IRERRIRIUES IS - ELIBHIENEIN - PRI SR - 2 <Del>#t
HEA BIOS #iE i RILUETT IEMERIREE

FERITILS B R TR EREBAN - SRETTESERS -

NF-M2 nView 5-1

B
&%



¥

¥

B3, [P 2 (BRRAEERR CMOS ZoRHEHE TR ERVIRH - [FIIRF A A L It
FRMERER - PRI TR ATX B AR -

1 HRERMSER - RENAA EREAEERE ?
COTER TEAGSRSRE ) ZAT > SRS IR B TR -

RHSTT R LR
AR AR SRR T R S BT R -
HEITEES R L

S BERITA L ERIMIISEE (BT AR - BN R - ROIEBELUR RS ) o R
TREHTRI -

G WERFREATIR - GHR—REAR T RRRUR K BRI T LABIK -

G AWURAREER A IR o AT RERAYRC TR RS -

G AR AR - IR o B s DU AR E A

AIFRARALIBARE - FHRRIRDHIA T 25, RS FRRYSA R R HAth SIS - — (8 — el 222
Ao —EEEERABE TR -

EAERRMERAELRE
AIGRAEE S3 I B R RS T AR 28 A T+ 2 SR DR B P e e R A T
P ARBURRAT ERYE ¢ AR SRR T S © AT

G TR BIOS RfA -
S TN E R EB R -
b fE TG/ ARAE ) A S A LIRS -

D OHMAIRR TR ERE ?
DORRRIRE MRENER T ERSRRE -

o JHE : FEALHIRIZ A -
o ETEM : AW LUSHESIERYE TR -
o MR GEALRIEE
o HHALIIRA
o TRE ¢ A ERRILGR R RRE -
# 1 = AABXE LAk SCSI 29160 fizfis
5] 2+ AABXE 4iLi:BH - POST code Fi< AF
B 3 : AABXE (S3 BRI RAEH - )
o ERRIR ¢ A ERREIRISR SRACE -
5] - AABXE REV: 1.00

o BIOS fiiA « G A FHEM BIOS oA (fRm] LITERHEETEIS A S BIOS hiiA) -

o TRIREESES ¢ SATUURB SRR EGRE (MHZ) (AR &R -
] : Intel 650 3.4GHz (OC FSB=220MHz)

5-2
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%

FOIERERTE © AR A A R R R -
]+ ZCMER G © Kingston (KVR533D2N4/1G)
SUEREAE AR R

#] : 512M* 4PCS

SOTEEESLSE « # A BIOS & NIYEC Emey

] : SCIEBER ¢ 2.5-3-3-7 @533MHz

HERFERA - S NERRRO > 2R S ERERE U -

BT ¢ AT R R
51 - ATI RADEON X850 XT PE

FERRRHEIE=URA « A B UR-RREERE O -
] : Catalyst 5.12V

EIRIUEREGER « S ALTERI SRR R A5 -
TEVRBEREAR LB ¢ A SEAT AR IR L ME AR LB -

FEFEEE © AR - HAS LUK B8 - SERARERE 82 {F IDE (Master 52 Slave )
T G SATA #fl I > LUk RAID Z3FliRTE -

5] 1 : WD Caviar WD600 60GB (Hif#{F IDE2 master $#58 ) » Maxtor DiamondMax 10
SATA 300GB (Eif(r SATA 3 £45H )

51 2 : Maxtor DiamondMax 10 SATA 300GB *2 (;#if{F SATA 3 - SATA4RAID 1)

JEEBEEE ¢ G ARSI RS B -SRI S HiEEAE IDE (Master 502
Slave) =i SATA ¥55H [ -

HAmZEE - RIS ﬁﬁﬁzf‘:ﬁ%ﬁ%%%%?ﬁﬁﬁbﬂ%ﬁ USB Z&E > GifEiE izt - 4l
RIEIREREERIREAR - SRR EATA IR K USB 2EE 254 1H, -
{1 © AHA 29160 (ZZ8&EHA PCI 2 §#if¥) - Sandisk Cruzer mini 256MB USB Flash-disk -

PERFM © TR SR S EE S IRA -
51 = Microsoft Windows XP SP2 =kl -
%l = Microsoft Media Center Edition 2005 #3Zfi

FIRERGI © Rt Rifae e R 2 AR R AR RERIRS R R B A AR TR
B -

BRI S I e S T O RIS BT & oy - SR e [ K el B | U= S et =E e p S
( http://www.abit.com.tw/page/en/contact/technical.php) -

DOEBIRE TR P AR ERRBENERERET RMAERF?

DR F SRR A A R > SR UREEI R A WA ISR - SRRy
RMA Hhu 0B -
( http://www?2.abit.com.tw/page/en/contact/index.php?pFUN KEY=18000&pTITLE IMG)
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5.1.2 HEfif < TR

H[E
BT EMH
ot

%

ES-
TR -
BIOS ff K :
FRORRIE AR
EREME

e
&

¢l

e

i

o

e
&

Cl

fein

o

R
e
BB R
BRGEB AT :
BRUERRS :
GTRE
SBRE
HIRE :
(FEF:
PEMEAUE :
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5.1.3 Universal ABIT #4571

i)

AT
RENEERNERAT
HALHIPIEE 114 i 323 5%
Fafh © 886-2-8751-3380

{457 : 886-2-8751-3381

7% © sales@abit.com.tw
TS © market@abit.com.tw

al

Jv3EM ~ =M
Universal ABIT (USA) Corporation

2901 Bayview Drive, Fremont, CA 94538,
U.S.A.

#ah ¢ 1-510-623-0500

{85 : 1-510-623-1092

444l : http://www.abit-usa.com
H7TEW ¢ ventas@abit-usa.com
RMA 1.0, © http://rma.abit-usa.com

B - - BEEL ~ RINAIE ~ HTE
KRiE ~ RRARFD  FLEnE - ERMLE -
BHIE - fngit/en

Universal ABIT Austria Computer
GmbH

Schmalbachstrasse 5, A-2201 Gerasdorf /
Wien, Austria

BTG ¢ 43-1-7346709

{HHE : 43-1-7346713

I4& « office@abit-austria.at

#44l - http://www.abit-austria.at

wE - FWE
Universal ABIT UK Corporation

Unit 3, 24-26 Boulton Road, Stevenage,
Herts SG1 4QX, U.K.

T3 1 44-1438-228888
{41  44-1438-226333

L&

Universal ABIT (Shanghai) Co. Ltd.

LR B 1089 SRS KE 19 2
(4 200030)

HiE: (86-21) 54102211

fE3: (86-21) 54104791

Mtik:  http://www.abit.com.cn

B B =R (8 ~ LA BRE) -
EE ~ AR -~ mS - AES - HE -~
R - W BT Wt

Universal ABIT NL B.V.

Jan van Riebeeckweg 15, 5928LG, Venlo,
The Netherlands

FEEE © 31-77-3204428
fHE : 31-77-3204420

R

Universal ABIT Poland (f{F151)
Strzegomska 310/2, 54-432 Wroclaw
BEaE  +48-71-718-12-39

%% + Grzegorz Morgiel

Russia
Universal ABIT Russia ({0 R)

4% © info@abit.ru
#auk - www.abit.ru

TEHE
Universal ABIT Turkey ({0 E)
E2E 1 90 532 211 6860
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